
 

 

  

 

Prepared by: 

Sword South Africa (PTY) LTD 

 

CUBA Desktop Client User Guide 



 

       

  

CUBA Desktop - User Manual Page | 2 

TABLE OF CONTENTS 

 

1. Introduction .................................................................................................................................................. 5 

2. Purpose of the CUBA User Guide .............................................................................................................. 5 

3. Installation .................................................................................................................................................... 5 

3.1 Software Prerequisites ....................................................................................................................... 5 

3.2 User Login Prerequisites .................................................................................................................... 5 

3.3 Installation CUBA Desktop ................................................................................................................. 5 

4. CUBA Login ................................................................................................................................................... 8 

5. Settings ......................................................................................................................................................... 8 

6. Uploading XML Files .................................................................................................................................. 12 

6.1 Manual Upload................................................................................................................................... 12 

6.2 Auto Upload ....................................................................................................................................... 13 

7. Validating XML Files .................................................................................................................................. 15 

8. Submitting XML Files ................................................................................................................................. 16 

9. Viewing XML Files ...................................................................................................................................... 19 

10. Messages ................................................................................................................................................ 24 

11. History Logs ........................................................................................................................................... 26 

11.1 Error Logs .......................................................................................................................................... 27 

11.2 Usage Statistics ................................................................................................................................. 28 

12. Locking the Application ........................................................................................................................ 28 

13. Searching ................................................................................................................................................ 29 

14. Help Function ......................................................................................................................................... 30 

15. Training Checklist .................................................................................................................................. 33 

Sign-Off ................................................................................................................................................................ 34 

 

 

  



 

      Page | 3 

 

 

 

CUBA Desktop - User Manual 

TABLE OF FIGURES 

Figure 1: CUBA Login page ............................................................................................................ 8 

Figure 2: Settings menu ................................................................................................................ 8 

Figure 3: Processing Settings window ............................................................................................. 9 

Figure 4: Folder Settings window ................................................................................................. 11 

Figure 5: Upload icon .................................................................................................................. 12 

Figure 6: Upload files window ...................................................................................................... 13 

Figure 7: C:\CUBAFolder .............................................................................................................. 14 

Figure 8: xml files dumped/pasted ............................................................................................... 14 

Figure 9: CUBA Desktop Client uploaded xml files ......................................................................... 15 

Figure 10: Validate single xml file ................................................................................................. 15 

Figure 11: Validate multiple xml file ............................................................................................. 16 

Figure 12: Sign and Submit xml file .............................................................................................. 16 

Figure 13: View xml file ............................................................................................................... 21 

Figure 14: individual xml files ...................................................................................................... 21 

Figure 15: view individual xml file ................................................................................................ 22 

Figure 16: [Domain] Application View window .............................................................................. 23 

Figure 17: Printing an xml file ...................................................................................................... 24 

Figure 18: Incoming messages .................................................................................................... 25 

Figure 19: Outgoing messages ..................................................................................................... 26 

Figure 20: Error logs window ....................................................................................................... 27 

Figure 21: Search field ................................................................................................................ 29 

Figure 22: Online Help ................................................................................................................ 30 

Figure 23: Status Codes window .................................................................................................. 31 

Figure 24: Country Codes window ................................................................................................ 32 

 

 

 



 

       

  

CUBA Desktop - User Manual Page | 4 

Version Control  

Version Date Author(s) Comments 
Checked/ 

Reviewed 

1.1 15/04/2013 Jeminah Maema 

CUBA Client User Manual 

Updated according to 

v1.7 

 

1.1.1 25/07/2013 Moeti Shakung 
Updating all sections and 

screenshots 
 

1.1.2 12/08/2013 Moeti Shakung 
Updating all sections and 

screenshots 
VME 

 

  



 

      Page | 5 

 

 

 

CUBA Desktop - User Manual 

1. INTRODUCTION 

 

This document contains a step by step guide for CUBA (CIPC Utility for Bulk Applications) users. It will 

enable the users to utilize the functionality that the application contains. 

 

2. PURPOSE OF THE CUBA USER GUIDE 

 

This document serves as a guide on how to use CUBA Desktop Client and it comprehends the 

installation process of the application. 

 

3. INSTALLATION 

3.1 SOFTWARE PREREQUISITES 

 

The PC utilized must have the following software installed: 

 Windows 7/8/XP/Vista 

 Microsoft .net Framework 4.0 

 CUBA Desktop Client (latest version 1.0.0.6) 

 Internet connection 

 Windows Installer 3.1 

3.2 USER LOGIN PREREQUISITES 

 

The user should already have the following: 

 Username and password 

 Test Data:  

− xml file 

− Word document 

− Invalid xml file 

 An electronic digital certificate 

3.3 INSTALLATION CUBA DESKTOP  

 
In order to download and install CUBA Desktop; enter the following link on your web browser: 
http://efile.cipc.co.za/Downloads.aspx 
 

http://efile.cipc.co.za/Downloads.aspx
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The first screen that will appear displays the latest version of CUBA as well as the link for 

downloading CUBA. 

1. Click on the link first link  Installer Version, as shown below: 

 

 

2. Click on the dropdown list and select open.  

3. Run file CUBA_ClientSetup.msi 

4. After running the CUBA_ClientSetup.msi, the following screen will appear: 
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5. Continue with the installation by continuously clicking the Next button until the following 

screen is shown. 

 

 

6. Click Close. The CUBA Client shortcut /Icon will be displayed on your desktop. Find the CUBA 

Client short cut on your desktop. 

 

-Double Click the icon to open CUBA Client 

 

By default the application creates a folder on the C:\CUBAFolder.  
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4. CUBA LOGIN 

The user will be directed to this page after clicking the icon on the desktop. The user should enter 

their login credentials: Username and password 

 

Figure 1: CUBA Login page 

The user should click the login button after entering their credentials. 

NB: The application may take time to authenticate if you are using the application for the first time.  

 

5. SETTINGS 

It is advisable to change settings on CUBA before any activities take place. On the menu toolbar, the 

user should click on Settings 

To change the operational folders click on Settings then select Defaults shown below: 

 

Figure 2: Settings menu 

The default screen will be displayed as shown below:   
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Figure 3: Processing Settings window 

The Defaults settings screen above consists of the Processing Settings tab and Folder Settings 

tab. 

The Processing Settings tab entails the following settings that can be changed:  

a) Overwrite existing files- The user can decide what action to be taken when uploading 

duplicate xml files. By selecting “Yes”, the files will be overwritten without warning. 

“No”- Does not allow users to overwrite files without warning during File Upload. 

 

b) Allow offline login- The purpose of this setting is to allow the user to choose to have 

accessibility to CUBA with or without network connection. 

When you select “Yes” it will allow you to be authenticated locally, without internet 

connection. The “No” option requires the user to be always connected to the internet.  
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c) Auto watch folder for new XML files- This setting allows the user two options of uploading 

an xml file; either automatically or manually. 

The “Yes” option allows you to dump files into a folder (Auto watch folder path) so that the 

system auto uploads them into CUBA Client. Files that are dumped in this folder will 

automatically be available on the uploaded files on the application. 

The application will not allow files to be automatically uploaded when choosing the “No” 

option. When dumping the files in the Auto watch folder path, the files will not be 

processed until you manually upload them.  

 

d) Auto submit XML files- This setting allows you to submit files automatically when checking 

the following statement on the Automatic digital signing window (see Settings> Signing 

Settings) which states “I agree to using my electronic digital certificate to allow CUBA Client 

Desktop system to automatically validate digitally sign, submit xml files in the background 

without user intervention”  

By selecting “Yes” this allows the XML files to be submitted automatically; this means that 

the xml files will be validated and submitted automatically (in the back end).  

The “No” option means that the user is required to upload, validate and submit the XML files 

manually. 

 

e) Clear temporary files at logon- This setting is necessary to control the performance of the 

application, files that are not cleared will take up most of the space in the application hence 

it is advisable that you select the “Yes” option. 

By selecting “Yes”; temporary files will be deleted when logging in again. Files will not be 

saved when choosing the “No” option. 
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Figure 4: Folder Settings window 

The above screen displays the Folder Settings tab. The fields are titled and allow the user the option 

to browse for the file they wish to extract from. 
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6. UPLOADING XML FILES 

Users need to upload files into CUBA. There are two ways in which the user can upload files in CUBA 

Client: Manual Upload, and Auto Upload. 

6.1 MANUAL UPLOAD 

To manually upload an XML file click on the Upload menu or the  Icon. 

 

Figure 5: Upload icon 

When submitting manually the following window will appear; this will enable the user to browse for 

files to they want to upload. 
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Figure 6: Upload files window 

1) Click the Browse button to find XML files to upload. 

2) After Clicking Browse, navigate to and select an XML File 

3) Click Open 

4) After clicking open the user will be taken back to the above screen 

5) On the Upload files Screen, click the Upload button.  

Note: The uploaded files will now be included in the list of uploaded files. 

6.2  AUTO UPLOAD 

The second option is to automatically upload. The following steps will take you through the process 

of automatically uploading an xml file:   

1) Click Settings> Defaults 

2) On the settings screen, Set the Auto watch folder for new XML files option to Yes 

3) Note the folder specified in the Auto watch folder path setting 

4) Paste an XML file in the folder specified in the Auto watch folder path. 

 

All XML compliant files can be uploaded, but only known XML file types can 

successfully validate. 

 

5) Once processed, the file pasted above will appear in the list of submitted files.  
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All XML compliant files can be uploaded, but only known XML file types can 

successfully validate. 

The user should access the C:\CUBAFolder, as shown below:  

 

 

Figure 7: C:\CUBAFolder 

The screen below shows the xml files (highlighted) that have been pasted within the CUBAFolder 

 

Figure 8: xml files pasted 

Within a few seconds, all the xml files will disappear. This means that the xml files have been 

uploaded in CUBA Desktop Client. 

To see the files, return to CUBA Desktop Client, and refresh the page, as shown in the screen below: 



 

      Page | 15 

 

 

 

CUBA Desktop - User Manual 

 

Figure 9: CUBA Desktop Client uploaded xml files 

The list of xml files will appear in a data grid. The status of those xml files should be “Not submitted”  

7. VALIDATING XML FILES 

 

Validation is performed only to check if the required fields have been completed.   

All uploaded files are visible in the data grid.  To validate a single XML file; right click it and select 

Validate. 

 

 

Figure 10: Validate single xml file 

 To validate multiple XML files, select the check box next to the file that you want to validate. Click 

the Validate button on the bottom right corner of CUBA Client’s main screen. 
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To validate all XML files, click on the Select all icon and all the files will be checked. Click on the 

Validate button at the bottom right corner of CUBA Client’s main screen as shown below: 

 

Figure 11: Validate multiple xml file 

8. SUBMITTING XML FILES 

Only files that have been validated successfully can be submitted.  

 To submit, right click a validated XML file and click Sign and submit on the context menu.  

 

Figure 12: Sign and Submit xml file 
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Submission of XML files requires an internet connection, preferably fast ADSL. 

The Terms and Conditions window will appear. The user should read them thoroughly and accept 

them by selecting the “I agree” option. 
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The user will then be requested to enter their digital certificate and password for safety purposes. 
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9. VIEWING XML FILES 

There are different statuses for each activity; these statuses are represented by the following 

colours: 

 

 The file has been submitted and is being processed in CUBA server the status will change 

to “In progress” 

 When the file has been submitted to the server  the status will be “Submitted” 

 “Not Submitted” is the default status after an XML batch has been uploaded 

 When the file has been successfully validated against the XML Schema the status will be 

“Validated” 

The user can choose to display XML files of a particular status only.  By doing so, click on the View 

Menu and select the status you wish the xml files to be displayed in.  

 

There are other ways to access the different view options, and they will be explained as follows: 

1) Submitted – All the files that have been submitted to the server will be displayed. Click the 

Submitted Icon (in red) to view the submitted files. 
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2) Not Submitted – Displays all files that have been uploaded but have not yet been submitted. 

Click the Not Submitted Icon (in red) to view the files that are not yet submitted. 

 

 

3) Validated –Ffiles that have been successfully validated against the XML Schema will be 

displayed. Click the Validated Icon (in red) to view the validated files. 

 

 

 

4) Error XML – Displays all XML Files that have had errors while submitting. Click the Error XML 

Icon (in red) to view the Error XML files. 

 

 

5) Show all – Shows all files that have been uploaded regardless of their status. To view all XML 

files Click on the following menu: View > Show All 

 

To view the xml file, right click on the file and choose the View option. 
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Figure 13: View xml file 

Within the file, contains the individual xml files, as seen below in a grid list:  

These are the fields that are included when viewing the xml file: Unique no. ; Mark/Title; 

Classification and Status 

 

Figure 14: Individual xml files 

The individual xml files allows for the following options when right clicking: 

 - View, print, and delete 
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Figure 15: View individual xml file 

There are two options for viewing the xml file:  

1) Double click or 

2) Right click on the xml file and choose View 

The screen below illustrates the xml file that has been opened and/or viewed. Within the window 

are the details as well as the supporting documents of the particular domain viewed. 
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Figure 16: [Domain] Application View window 

The xml file will be saved temporarily, and the action thereafter will be determined by the settings: 

see Settings>Defaults> Clear temporary files at logon) 

By closing the window, the user will be directed back to the list of xml files 

In order to print the xml file,  

1) Right click on the file and select print. 

Take note that the document is viewed in pdf format. 
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Figure 17: Printing an xml file 

The above screen is a pdf that is populated with information from the validated xml file. Use the 

print icon to print the document. 

10. MESSAGES  

 

Delivery receipt messages and any other messages from the server after submission of XML files can 

be viewed by clicking the messages menu. 

When the user clicks the Messages menu, two different types of messages are displayed, Ingoing 

and Outgoing 

 

1) To view the Messages, the user must click the Messages menu, and then click Incoming. 

 

The following screen will then appear; showing all the messages that have been received. 
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Figure 18: Incoming messages 

The Incoming messages screen allows the user to view the details of the message (included is the 

recipient, subject, time and date) received. 

The Full Message tab displays the complete message. 

 

2) By clicking on the same menu on Outgoing Messages, a list of all the messages that have 

been sent out by the user will be shown. 
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Figure 19: Outgoing messages 

 It is important that the user is familiar with their email contact list since it is very 

risky to open unknown mail. 

 

11.  HISTORY LOGS  

  

 The History logs are logged on the users’ machine and show errors that have occurred in the 

application for the users’ reference. CUBA Client has 2 types of Logs available for the user to view: 

1) Error Logs 

2) Usage statistics 
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11.1 ERROR LOGS 

 

3) To view the History logs, the user must click the History Logs menu, and then click Error 

Logs as shown below: 

 

4) The following screen will then appear showing Errors that have occurred 

 

Figure 20: Error logs window 

On the above screen, the errors are displayed in a list. 

 Saving the Logs: The user can click the Save button to save the error log for future 

reference. 

 Clearing Logs: The error Logs can be cleared by clicking the Clear Logs button. This will 

delete all errors that are shown on the error log and a new clean log file will be created. 

 

It is advisable to save the Error Logs first before clearing for future reference 
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11.2 USAGE STATISTICS 

 
To view Usage statistics, the user must click the following menu: History Logs > Usage Statistics as 

shown below: 

 
 

 

Figure 21: Usage statistics window 

The usage statistics indicates the number of xml files within the application for each domain. 

12.  LOCKING THE APPLICATION 

In an instance where the user doesn’t want to exit, the lock function will work best.  
 

 

To lock the application, click on the  Icon on the toolbar.  The application will remain open 

but locked, which ensures that no one can temper with the submissions unless they have a password 

of the user who is currently logged on. 

To unlock the application you will need to enter the password of the user who is 

currently logged in! 
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13. SEARCHING  

 

The user can search according to a domain. The top menu consists of an empty dropdown list; this 

list has four of the domains (Trade Marks, Patents, Designs, Copyright) the user can choose from. 

 

Figure 22: Search field 

E.g. Choose one domain you wish to search for;  

On the screen below, the user searched for all Patents regardless of the status. As shown below: 

 

However the Patents xml file can be viewed by status. The screen below shows all the patents xml 

files with the status “Not submitted” 
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1)Select the domain you wish to search for. 

2) Select the status on the View menu or the icon (submitted, not submitted, validated, 

submission error and show all) 

3) All the Patent xml files with the specified status will be displayed. 

14. HELP FUNCTION  

 

The Help Menu has four informational submenus: 

1) Online Help 

 

Figure 23: Online Help 

The online help will link the user to a webpage that gives information that is required by the user. 
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2) Status Codes 

 

The status code window is a guide for the user with the description of the statuses used within the 

application. 

 

Figure 24: Status Codes window 
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3) Country Codes 

This is to serve as a reference given to country names used within the xml files.  

 

Figure 25: Country Codes window 

4) About CUBA Desktop Client 

This window contains information about CUBA Desktop Client such as: 

− The version of CUBA 

− The URL where CUBA can be downloaded 
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15. TRAINING CHECKLIST 

The following is a checklist that should be filled in by you (user); this assures that you have been 

taken through training by the SSA Training Team. 

Complete the training checklist below for CUBA Desktop Client  

 

Yes 

 

No 

 

1. Verify that you make use of  the test cases  
  

2. Have you been taken through the correct installation of CUBA Desktop 

Client? 
  

3. Verify that  internet connection works  properly 
  

4. Have you successfully logged in with your credentials (check username). 
  

5. Have you been taken through the functionality of all the buttons and 

icons? 
  

6. Have you been taken through the trade mark life cycle?  E.g. first upload, 

then validate 
  

7. Do you know what to expect after each activity? 
  

8. Does the system communicate with you? 
  

9. Do you have the required software specifications?  
  

10. Does the help function work properly? 
  

11. Did you validate all information? (Physical to electronic) 
  

12. Have you changed settings to the recommended settings? 
  

13. Verify that you understand the terms used 
  

14. Verify that the country codes are helpful 
  

15. Was the training sufficient and were you given a platform to ask questions? 
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